Networking Basics
Naming your Computer

M |n this window, enter the
Computer name

B Select Workgroup and enter
the name of the Workgroup

B All computers on your
network must have the same
Workgroup name.

B Click OK

Computer Name Changes

You can change the name and the membership of this
computer. Changes may affect access to network resources.,

Computer name;
| Office

Full computer name:

Office

More...

dember of
() Domair:

|
() Workigroup:
I Accounting

Checking the IP Address in Windows XP

The wireless adapter-equipped computers in your network must be in the same IP Ad-
dress range (see Getting Started in this manual for a definition of IP Address Range.)

To check on the IP Address of the adapte

r, please do the following:

B Right-click on Cisable
the Local Area

Connection icon

in the task bar REpSF

M Click on Status

View Gwailable Wireless Metworks

Cpen Metwork Connections
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Networking Basics
Checking the IP Address in Windows XP

This window will appear. Wireless Network Connection 7 Status |E||E|
-GEHEIEH‘ Support )
] Click the |nternet Pratocal [TCPAR)
Support tab Address Type: Assigned by DHCP
[ IP Address: 152.168.0.114 ]
Subnet Mask: 255.255.255.0
D efault [Gateway: 192.168.0.1

[ ] Click Close

Cloge

Assigning a Static IP Address in Windows XP/2000

Note: Residential Gateways/Broadband Routers will automatically assign IP Addresses
to the computers on the network, using DHCP (Dynamic Host Configuration Protocol)
technology. If you are using a DHCP-capable Gateway/Router you will not need to
assign Static IP Addresses.

If you are not using a DHCP capable Gateway/Router, or you need to assign a Static
IP Address, please follow these instructions:

‘ l' _ontrol Fanel

u Go to Start @ Taur ‘Windows 5P

1‘{-! Paink
= \
t_j/l Help and Support

Fles and Settings Trarsfer =

_@ Wizard I) Search

Hé Printers ard Faxes

u Double-click on
Control Panel

all Programs P =7 fun,.,

ﬁ| Lug 2T rm | Turi S Cunpuler




Networking Basics
Assigning a Static IP Address in Windows XP/2000

B- Control Panel

File  Edit Wiew Favaorites Tools Help
I\) Back -\J l,} f') Search | - Folders
Address G- Control Panel
o M. Accessibility Options
E Control Panel o \dd Rardwars
add or Remove Programs
. DOUbIe-CIICk G’ Swikch ko Categary View d Adminiskr ative Tools
on Network
Connections SEedh
R o Upt?late ‘& Game Contralers
&) Help and Support P Internet Options
Taskbar and Start Menu
i User Accounts
"% Network Connections
Fle Edt View Favorites Tools Advanced Help
Qesck - () (T Dseach [ Folders
b Network Connections
A Name
Network Tasks LAN or High-Speed Internet
Create anew
connection Disable
. . % Set up a hame ar smal Status
B Right-click on Local Area sifice rework Repai
. & Disabls this network
Connections devks kg Comnectons

&, Repair this connection
=]} Rename this connection

) view status of this
connection

Change settings of this
connechion

Create Shorteut
Delste
Rename

B Double-click on
Properties Dther Places

[+ Control Panel i
& My Network Places

(L) My Dacuments

j My Computer

Details

4 Wiew or change settings For this connection, such as adapter, protacol, or madem configur
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Networking Basics
Assigning a Static IP Address
in Windows XP/2000

B Click on Internet Protocol
(TCP/IP)

Click Properties

Input your IP address and
subnet mask. (The IP
Addresses on your network
must be within the same
range. For example, if

one computer has an IP
Address of 192.168.0.2,
the other computers should
have IP Addresses that are

L L ocal Area Connection, Properties

General | Authentication | Advanced

Connect uzing:

-Link DFE-53

| B3 [

Thiz connection uzes the following iterns:

[ ECIient for Microsoft Metworks
vl @ File: and Prinker Sharing for Microzaoft Networks
05 Packet Scheduler
3= Intemet Protocol [TCPAP)

) | )

Allows vour computer to access resources on a Microsoft
network.

[ Install... Uninstall

Description

[ 5how icon in notification area when connected

Ok ] [ Cancel

sequential, like 192.168.0.3
and 192.168.0.4. The subnet
mask must be the same for
all the computers on the
network.)

Input your DNS server
addresses. (Note: If you
are entering a DNS server,
you must enter the IP
Address of the Default
Gateway.)

The DNS server information will be supplied
by your ISP (Internet Service Provider.)

B Click OK

Internet Protocol (TCP/IP) Properties @[z|

[ General |
“You can get [P settings aszigned automatically if your network supportz
this capability. Otherwise, you need to ask your network. administrator for
the appropriate IP settings:
() Obtain an IP address automaticaly
(& Use the following IP address?)
IP adcress [132 166, 0 .51 |
Subnet mask: 255255255 0 |
Dretault gateway: i |
(@ Use the following DMS server addlesses:)
Prefened DNS server |
Alternate DNS server: [
C )
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Networking Basics

Assigning a Static IP Address with Macintosh OSX

(- X:]

System Preferances

« a0

Thowal | Dirslays Sound Navwseh Seanup Dik

B Gotothe Apple Menu and select ';- =
System Preferences e e

B Click on Network

B Select Built-in Ethernetin the
Show pull-down menu

m Select Manually in the
Configure pull-down menu

B |nputthe Static IP Address,
the Subnet Mask and the
Router IP Address in the
appropriate fields

B Click Apply Now

COSBTVDY  Colortyns

Intermet & Netwo
C
o

&=

Canerad

=]

hepiers

2

a0 & 1L &

Irnernitiondl  Logia Bems My Accowen  Scroes Diects

[ )

d
Goargy  Etoard  Meuse Sound
S

System
a4 & & & § 4 @
Accousts Clas DawhTime  dofware  Spesch  SumpOuk Uswesd
Undate Acests
I Hesyork. E=T
« =A@ O
Show All | Displays Sound Mectwork Startup Disk
Location: | Automatic K3}
——h
HCP Router
Configure « Using DHCP
Using BootP
me Servers (Ootioadl
WP Address: 192,168.10.7
tPravided by DHCP Server)
Subnet Mask: 255.255.255.0
Router: 192.168.10.1 Search Domaing iDptianall
DHCP Client 1D:
iOpticnal
Example: angle com. euthiink net
Ethernet Address. 00:30.ba:b0.00.05
(@) Cliek the lock to prevent fug y Apoly Naw
e’ WAEB% .y W
‘ee Metwork a

“« =A@

ShowAll  Displays Sound Network  Startup Disk

=

Location: | Automatic

Show. | PCI Ethernet Slot C1

m

fm’mr | AppleTalk | Proxies

Configure: | Manually ¥ ]

Subnet Mask: 255.255.255.0

Router: 192.168.10.1

P Address:  192.168.0.19

Etherner Address: 00:50:ba:b0:00:05

Domain Name Servers (Dotional)

Exampie: appie.com, sarthlink net

&

L) CII(AIh!m\t&ﬁ!nnllu").*".;‘.'aa.n v 4R ‘ Apply Now '
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Networking Basics
Selecting a Dynamic IP Address with Macintosh OSX

[X5) Sitam Prefereces [=)
= HA0 4
mm = @ee e
B Go to the Apple Menu and select Ot e e e
System Preferences e = v m % 8
. o (¢ ;
B Click on Network e @ -2
Sysiem
& .E? P8 2
‘88 Netwark =]
« =A@ a
Shaw All Displays Seund MNetwork Starep Disk
B Select Built-in Ethernet in the Location: (Avtomaie 1)
Show pull-down menu | T -
[ Wy — —
q .-Ill-:i;hg E-HCP“ :
- . L39 Reot wame Servers (Optanall
B Select Using DHCP in the e — ]
H Provided by OHCP Server)
conflgure pu”_down menu Subnet Mask: 255.255.255.0
Router: 192.168.0.1 Search Domains __ topticast)
OHCP Client ID-
Optional
S Examply: apple.com, sarthiink, net
‘3‘ Click the lock to prevent further changes,
eo Network (=]
. « =A@ 3
B Click Apply Now ShowAll | Duplays Sound Metwork Startug Disk
Location: | Automatic 'lj
Show:  Bullt-in Etherner ﬂ
frEPPY prrot | AovleTalk | Provies |
B The IP Address, Subn,et oty (TR -
mask, and j[he Routgr sIP e
Address will appear in a few 1P Address: 192.166,0.160
(Prowided by DHCP Senver))
seconds Subret Mask: 255.255.255.0
Router: 192.168.0,1 Search Domains {Opuianal
DHCP Client ID:
(Dptioasll
Example. appée.com. earthiink.net
Ethernet Address: 00.06:96:79:.de:5a
'j-_‘. Click the lock 1o prevent further changes. " Apply Now )




Networking Basics
Checking the Wireless Connection by Pinging in Windows XP and

2000

m Go to Start > Run >
type emd. A window

Checking the Wireless Connection by Pinging in Windows Me

and 98

similar to this one
will appear. Type
ping XXX.XXX.XXX.
XXX, where xxx is
the IP Address of
the Wireless Router
or Access Point.

A good wireless

connection will show

four replies from
the Wireless Router
or Acess Point, as
shown.

Go to Start > Run
> type command.
A window similar

to this will appear.
Type ping XXX.XXX.
XXX.XXX where xxx
is the IP Address
of the Wireless
Router or Access
Point. A good
wireless connection
will show four
replies from the
wireless router or
access point, as
shown.

WINDOWS\System32\cmd.exe

soft Windows XP [Version -26881
(C) Copyright 1985-2881 chxuaoft Corp.

F:“Documents and Settings“~lab3’>ping 192.168.8.58

Pinging 192.168_8.58 with 32 hytes of data:
Reply from 192.168. g SB byt

2 time<{ims TTL=64
2 time{ims TIL=64
2 time{ims TIL-64
2 time<{ims TTL=64

statistics for 192.168.0.58:

ackets: Sent 4. Rece d = 4, Lost = B (B@% loss).
fpproximate »ound trip times mnilli—zeconds:

Minimum = Bms. Maximum = Average = Bms

=“\Documents and Settings\lab3>_

"2 MS-DOS Prompt

C:\WINDOWS\DESKTOP>cd. .

C:\HINDOWS >cd. .
C:\>ping 192.168.8.1

f data:
me<1@ms TTL=64

me<{1@ms TTL=64
me(lﬂm., TTL=64

Pinging 192.168.8.1 with 32 hy
Reply from 192.168

TIL=64
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DI-524UP Wireless Broadband Router. We cover various aspects of
the network setup, including the network adapters. Please read the following if you are
having problems.

Note: It is recommended that you use an Ethernet connection to
configure the DI-524UP Wireless Broadband Router.

1.The computer used to configure the DI-524UP cannot access
the
Configuration menu.

[ |
Check that the Ethernet LED on the DI-524UP is ON. If the LED is

not ON, check that the cable for the Ethernet connection is securely
inserted.

Check that the Ethernet Adapter is working properly. Please see
item 3 (Check that the drivers for the network adapters are
installed properly) in this Troubleshooting section to check that

the drivers are loaded properly.

B Check that the IP Address is in the same range and subnet as the
DI-524UP. Please see Checking the IP Address in Windows XP

in the Networking Basics section of this manual.
Note: The IP Address of the DI-524UP is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.

Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

Do a Ping test to make sure that the DI-524UP is responding. Go to
B Start>Run>Type Command>Type ping 192.168.0.1. A successful

ping will show four replies.

B [ =5 Al
- Note: If you have
changed the default IP
; Address, make sure to
eply from 192.168.9.1 time< h
Ronly fran 138 168:0:17 hotat 52 Linecan: 11183 ping the correct IP Ad-
e rom 1= s tine{1Bms b .
o dress assigned to the
et w el DI-524UP.

rip
- Maximum = @ms. Average =
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Troubleshooting
2. The wireless client cannot access the Internet in the

Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection
icon in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

correct available network, as shown in the illustrations below.

Connect to Wireless Network @@
Disahle The following network(z) are available, To access a network, select
it from the list, and then click Connect.
Status
Repair Available network.s:
i alan ~

E dan

i nn s

If you are having difficulty connecting to a network, click Advanced.

[ Corinect l[ Cancel ]

B Check that the IP Address assigned to the wireless adapter is within
the same IP Address range as the access point and gateway. (Since
the DI-524UP has an IP Address of 192.168.0.1, wireless adapters must
have an IP Address in the same range, e.g., 192.168.0.x. Each device
must have a unique IP Address; no two devices may have the same IP
Address. The subnet mask must be the same for all the computers on
the network.) To check the IP Address assigned to the wireless adapter,
double-click on the Local Area Connection icon in the taskbar >
select the Support tab and the IP Address will be displayed. (Please
refer to Checking the IP Address in the Networking Basics section of
this manual.)

B [fitis necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you
are entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable router,
you will not need to assign a Static IP Address. See Networking

Basics: Assigning a Static IP Address.)

58



Troubleshooting

3. Check that the drivers for the network adapters are
installed properly.

You may be using different network adapters than those illustrated here, but this

procedure will remain the same, regardless of the type of network adapters you are

using.

m Go to Start >
My Computer >
Properties

m Select the
Hardware
Tab

B Click Device
Manager

IJ:J Outlook Express

B _ommand Prompl

v MM Explorer

'® Tour YWindows %P

_f\] My Pickures

j My Music

e
Open

.g My Network  Explore
Windows Media Player | Search
‘ Bﬂ Control Panel% Manage
Wil windows Movie Maker | Map Metwork Dri
ap Metwork Drive. ..

E* Connect To
]

Disconnect Metwaork Drive. ..

=g Printers andf  Show on Deskkop
| Filzs and Settings Transfer - Rename
Mieard 9) Help and Supy

Al Mrograms D

s start

System Properlies

Syatem Restoce
Gensal

Add Hardware Wizad
i The Add Hadware Wizard helps you instal hardware

[ AddHudwasWiead |

Devica Manager

2% The Device Manager kste all the hardware devices nstalied
on poul computel. U the Device Managa 10 change the
propenes ol ay davica

[ Drivat Signing Hz Device Manage S

Haedweare Frofiles

s Hardware profiles provide a way for you to set up and store
&gl difecant hydwae confgations

[ Hadwaeproties |

[ﬁx ][MJ]
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Troubleshooting

B Double-click
on Network
Adapters

B Right-click on D-Link
AirPlus DWL-G650
Wireless Cardbus
Adapter (In this example
we use the DWL-G650;
you may be using other
network adapters, but
the procedure will remain
the same.)

B Select Properties
to check that
the drivers are
installed properly

B Look under Device
Status to check that the
device is working

properly

B Click OK

E: Device Manager

File  Ackion  Miew  Help

CIEE Y Y

e

B-E-E-E-E-E-E-E-E-E-E-E)

PM
] ﬁ Batteries
iy Computer

e Disk drives

'i Displayy adapters

ik DVDYCD-ROM drives
=%} Floppy disk controllers
g Floppy disk drives

IDE ATAJATAPT controllers

% Infrared devices

s Keyboards

Yy Mice and other pointing devices
& Monitors
ES MNetwork adapters

: -4 D-Link AirPlus DWL-G650
+| 5 P O adaprer
+- o Ports (COM & LPT)
+ 488 Processors

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

S T ”
General | Cri
Advanced | Driver | Resources |

:_:_-- | D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

Device type: Metwork. adapters
D-Link

PCI bus 129, device 0. function 0

Manufacturer:

Locatior:

Drewice status

i-This device iz working properly.

1f pou are having problems with this device, click Troubleshoat to
| |start the troubleshooter.

Troubleshoot...

Device usage:

' Lze thiz device [e;ahle]




Troubleshooting

4. What variables may cause my wireless products
to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this
manual for further information about the most advantageous placement of your D-Link
wireless products.

5. Why does my wireless connection keep dropping?

B Antenna Orientation- Try different antenna orientations for the DI-524UP. Try
to keep the antenna at least 6 inches away from the wall or other objects.

W If you are using 2.4GHz cordless phones, X-10 equipment or other home
security systems, ceiling fans, and lights, your wireless connection will degrade
dramatically or drop altogether. Try changing the Channel on your Router, Access
Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

If you have enabled Encryption on the DI-524UP, you must also enable encryption on
all wireless clients in order to establish a wireless connection.

B For 802.11b, the Encryption settings are: 64, 128, or 256 bit. Make sure that
the encryption bit level is the same on the Router and the Wireless Client.

B Make sure that the SSID on the Router and the Wireless Client are exactly the
same. If they are not, wireless connection will not be established.

B Move the DI-524UP and the wireless client into the same room and then test
the wireless connection.

B Disable all security settings. (WEP, MAC Address Control)
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Troubleshooting

6. Why can’t | get a wireless connection? (continued)

Turn off your DI-524UP and the client. Turn the DI-524UP back on again, and
then turn on the client.

Make sure that all devices are set to Infrastructure mode.

Check that the LED indicators are indicating normal activity. If not, check that
the AC power and Ethernet cables are firmly connected.

Check that the IP Address, subnet mask, gateway and DNS settings are cor-
rectly entered for the network.

If you are using 2.4GHz cordless phones, X-10 equipment or other home se-
curity systems, ceiling fans, and lights, your wireless connection will degrade
dramatically or drop altogether. Try changing the Channel on your DI-524UP,
and on all the devices in your network to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

7. | forgot my encryption key.

Reset the DI-524UP to its factory default settings and restore the other devices
on your network to their default settings. You may do this by pressing the Reset

button on the back of the unit. You will lose the current configuration settings.
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Troubleshooting

8. Resetting the DI-524UP to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the DI-524UP to the factory default settings. Remember that
D-Link AirPro products network together, out of the box, at the factory default
settings.

To hard-reset the DI-524UP to Factory Default Settings, please do the following:

B | ocate the Reset button on the back of the DI-524UP
B Use a paper clip to press the Reset button

B Hold for about 10 seconds and then release

m After the DI-524UP reboots (this may take a few min-
utes) it will be reset to the factory Default settings
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Technical Specifications

Standards
m |EEE 802.11g
m |EEE 802.11b
m |EEE 802.3
m |EEE 802.3u
VPN Pass Through/ Multi-Sessions
m PPTP
m L2TP
m [PSec

Device Management

B Web-Based- Internet Explorer v6 or later; Netscape Navigator v7
or later; or other Java-enabled browsers

B DHCP Server and Client

Advanced Firewall Features

m NAT with VPN Passthrough (Network Address Translation)
MAC Filtering

IP Filtering

URL Filtering

Domain Blocking

Scheduling

B Indoors — up to 328 feet (100 meters)
m Outdoors — up to 984 feet (300 meters)

Operating Temperature
B 32°F to 131°F (0°C to 55°C)

Humidity:
B 95% maximum (non-condensing)

Safety and Emissions:
m FCC,CE

Wireless Frequency Range:
B 2.4GHzto 2.462GHz
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Technical Specifications

LEDs:

Power

WAN

LAN (10/100)

WLAN (Wireless Connection)

Physical Dimensions:

m L=5.6inches (142mm)
m W =43 inches (109mm)
m H=1.2inches (31mm)

Wireless Transmit Power:
m 14dBm

Security:

m 802.1x

m WEP
WPA
WPA-PSK

External Antenna Type:
B Single detachable reverse SMA

Modulation Technology:
m Orthogonal Frequency Division Multiplexing (OFDM)

Power Input:
B Ext. Power Supply DC 5V, 2A

Weight:
m 0.44 Ibs. (2009)
Warranty:

m 1year
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Technical Specifications

Wireless Data Rates with Automatic Fallback:

54 Mbps
48 Mbps
36 Mbps
24 Mbps
18 Mbps
12 Mbps
11 Mbps
9 Mbps
6 Mbps
5.5 Mbps
2 Mbps
1 Mbps

Receiver Sensitivity:

54Mbps OFDM, 10% PER, -68dBm
48Mbps OFDM, 10% PER, -68dBm
36Mbps OFDM, 10% PER, -75dBm
24Mbps OFDM, 10% PER, -79dBm
18Mbps OFDM, 10% PER, -82dBm
12Mbps OFDM, 10% PER, -84dBm
11Mbps CCK, 8% PER, -82dBm
9Mbps OFDM, 10% PER, -87dBm
6Mbps OFDM, 10% PER, -88dBm
5.5Mbps CCK, 8% PER, -85dBm
2Mbps QPSK, 8% PER, -86dBm
1Mbps BPSK, 8% PER, -89dBm
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-524UP (192.168.0.1), you are not
connecting to the Internet or have to be connected to the Internet. The device has
the utility built-in to a ROM chip in the device itself. Your computer must be on the
same |P subnet to connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device.
If you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/’XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What's the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two
types of cable have different purposes

for different LAN configurations. EIA/TIA

568A/568B define the wiring standards 3 hite-Green
and allow for two different wiring color g ‘-B’*:ﬂge-manﬂe
codes as illustrated in the following 5 White-Blue
diagram_' . g gmi':g-%mwn
*The wires with colored backgrounds may 8 Brown
have white stripes and may be denoted 5684 CABLE END
that way in diagrams found elsewhere. .

1 White-Orange
How to tell straight-through cable from g g;i't‘g_%men
a crossover cable: 4 Blue
The main way to tell the difference 2 Whito Blue
between the two cable types is to ; Es:gitfn-ﬁmwn

compare the wiring order on the ends
of the cable. If the wiring is the same on 3686 CABLE END

both sides, it is straight-through cable. If one side has opposite wiring, it is a
crossover cable.

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable

is important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover

Hub/Switch uplink port to another Hub/Switch normal port - Straight-through 68



Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Step 3 Configure your Internet settings.

Go to Start>Settings>Control Panel. Double
click the Internet Options Icon. From the Security
tab, click the button to restore the settings to their
defaults.

Click to the Connection tab and set the dial-
up option to Never Dial a Connection. Click

the LAN Settings button

Nothing should be checked. Click OK

Go to the Advanced tab and click the
button to restore these settings to their

defaults

Click OK. Go to the desktop and close any open
windows
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the
same range of the device you are attempting to configure. Most D-Link devices use
the 192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as
shown then click OK.

Run

Tupe the name of a prograrn, falder, or document, and
Windows will open it for pau.

Open: |winipcfg j

0k i Cancel | Browse... |

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

B Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

m IP Configuration [_ [C]x]

i Ethernet Adapter Information

EEE
Adapter Addiess [0y

IP Address 0.0.00
Subnet Mask 0.0.0.0
Default G ateway

ak I Heleaze, | Hemew |

Release Al | Renew Al | HMore Info => |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.

Step 5 Click OK to close the IP Configuration window

70



Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.
Step 2 Type cmd then click OK.

Run liJ o

= Twpe the name of a program, Folder, document, or
- Internet resource, and Windows will open it Faor you,

Qpen: [ cmd w

[ K H Cancel H Browse, .. J

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway

S WINNT system32' CMD.EXE

rosoft Windows 2088 [Uersion 5. 21951
(C) Copyllght 1985-288@ Microsoft Corp.

D:“\>ipconfig

Windows 2888 IF Configuration

Ethernet adapter Local Area Connection:
Connection—specific DNS Suffix

IP AAAress. » » - « = - « o = « . = 192.168.0.174
Subnet Mask = 255.255.255.8

Default Gateway : 122.168.8.1

Step 4 Type exit to close the command prompt.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP
Address in the same range of the device you are attempting to configure. Most D-
Link devices use the 192.168.0.X range.

Make sure you take note of your computer’s Default Gateway IP Address. The
Default Gateway is the IP Address of the D-Link router. By default, it should be

192.168.0.1.

How can | assign a Static IP Address in Windows XP?

Step 1
Click on Start > Control Panel > Network and Internet Connections >

Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.
How can | assign a Static IP Address in Windows 20007?

Step 1 Right-click on My Network I

Places and select Properties. g o QIS Xl
vy U EC IS

Step 2 Right-click on the Local Network and Dislup - <o

Area Connection which represents P

your network card and select —

Properties. e

21

Connect using

I E§ D-Link DFE-530TX PCl Fast Ethernet Adapter

Highlight Internet Protocol (TCP/
IP) and click Properties.

Install Uninstall | Piopeties |

~Desciption
Transs

ntrol Pratocal/ntemet Protocal. The default
ovi urication

wide 3 i prol
acrass diverse intercornected netwark:

[¥ Shaw icon in taskbar when connected

oK Cancel
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows

20007 (continued)

Click Use the following IP Address and
enter an IP Address that is on the same
subnet as the LAN IP Address on your
router. Example: If the router’s LAN IP
Address is 192.168.0.1, make your IP
Address 192.168.0.X where X = 2-99.
Make sure that the number you choose
is not in use on the network.

Set the Default Gateway to be the
same as the LAN IP Address of your
router (192.168.0.1).

Set the Primary DNS to be the same
as the LAN IP address of your router
(192.168.0.1).

Internet Protocol {TCP/IP) Properties 21|

General

“You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask pour network administrator for
the appiopriate P setlings.

" Dbtain an IP address automatically

192 .168. 0 . ES
285.295.255. 0
192.168. 0 .1

& [btain DNS server address automatically

(% Lize the following IP address:
1P address:
Subnet mask.

Default gateway:

% Usg the follawing DNS server addresses:

192.188. 0 .1

Ereferred DNS server:
Alternate DNS server. 4 .2 .2 2
Advanced..

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click

Yes.

How can | assign a Static IP
Address in Windows 98/Me?

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My

Network Places) and select Properties

Highlight TCP/IP and click the Properties
button. If you have more than 1 adapter,
then there will be a TCP/IP “Binding”

for each adapter. Highlight TCP/IP >
(your network adapter) and then click

Properties.

Network

Configuraton | denificstion | Access Cortrol|

The following network components are installed

Client for Micrasoft Metwarks
D-Link DFE-530T% PCI Fast Ethernet Adapter (Rev &)

Add |

Aemove | Properties |

PFrimary Network Logon

[l tor Microsof Networks |
File and Print Sharing
Desciption
TCPAIR is the protocal you use ta cannect ta the Intemet and
widerarea netuiorks:
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in
Windows 98/Me? (continued)

(1P Propenies G |

Step 2 Click Specify an IP Address. =

Enter in an IP Address that is on the same ﬁ*'mmmmmmy

subnet as the LAN IP Address on your

router. Example: If the router’s LAN IP e

Address is 192.168.0.1, make your IP 1P Adsess

Address 192.168.0.X where X is between Subem ok (755755 755 1

2-99. Make sure that the number you choose

is not in use on the network.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router T
here (192.168.0.1). "jf“j‘"“_°"‘"“""‘“’°'“°""jj"f"
Click Add when finished. o
o
Step 4 Click on the DNS Configuration tab. — =

Click Enable DNS. Type in a Host (can
be any word). Under DNS server search
order, enter the LAN IP Address of your [ |
router (192.168.0.1). Click Add.

m
Birddrgs Aearced | 8IS
NS Conbguralon |am|muswﬁ-|mm
Step 5 Click OK twice. e

When prompted to reboot your computer, Hod [aien D |
click Yes. . DN |
After you reboot, the computer will now T |
have a static, private IP Address. —

|

[ ||

Step 5 Access the web management. Open your web

browser and enter the IP Address of your D-Link device in o | e |
the address bar. This should open the login page for the

web management. Follow instructions to login and complete the configuration.
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(IE AT&T-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based configuration by typing in the IP Address of the
router (default:192.168.0.1) in your web browser. The username is admin (all

lowercase) and the password is blank (nothing).

Connect to 192.168.0.1
= =

Step 2 Click the Home tab and click the ?\
WAN button. Dynamic IP Address is the B
default value, however, if Dynamic IP Address D524

is not selected as the WAN type, select A (€ acuin =l
Dynamic IP Address by clicking on the radio Pt | |
button. Click Clone Mac Address. Click [ et

on Apply and then Continue to save the

changes.

D-Link

Bulaamg Nertworks for Peopie

ArPlus G

802.119/2.4GHz Wireless Router

Home [LULUETTCL NSNS TS Status Help
DI—524|JP| S
WAN Settings
‘i Please select the appropriate option to connect to your ISP,
- @ Dynamic IP Address Choose this aption to obtain an IP address automatically
fram your ISP. {For most Cahle modem users)
Wizard () Static IP Address Choose this aption to set static IP information provided ta
you by your 1SP
ranen— () PPPoE Choose this aption if your ISP uses PPPoE. (For most DSL
Wireless users)
() Others FPTF , BigPond Cahle , L2TP and Telia
WAN P o At
e Host Mame Optional
‘__ FF e | ﬁl_)
WAC Address rFre Fre HF FHE JF
[
DHCP ————
Primary DMS Address 0000 |
Secondary DMS Address 000d |
WTU 11500
Auto-reconnect O Enabled & Disabled
Apply Cancel Help 75




Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

Turn the cable modem off (first) . Turn the router off Leave them off for 2 minutes.**
Turn the cable modem on (first). Wait until you get a solid cable light on the cable
modem. Turn the router on. Wait 30 seconds.

** If you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the
Status tab and click the Device Info button. If you do not already have a public IP

Address under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection
Step 1 Log into the web based configuration
by typing in the IP Address of the router oty S
(default:192.168.0.1) in your web browser. The ?\
username is admin (all lowercase) and the = —
password is blank (nothing). e

User name: | €8 =cmin VJ

password: [ |

Step 2 Click the Home tab and click the WAN @it
button. Select Static IP Address and enter your
static settings obtained from the ISP in the fields
provided.

If you do not know your settings, you must contact your ISP.

£02.11g/2.4GHz Wireless Router
Step 3 Click on Apply and then click orsae| ...
Continue to save the changes. :

Step 4 Click the Status tab and click
the Device Info button. Your IP Address
information will be displayed under the
WAN heading.

D 5 0
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into
the address window and hit the Enter key. When the password dialog box appears,
enter the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 In the username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,

please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.

77




Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an |IP Address.

Can | use my D-Link Broadband Router to share my Internet connection
provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1 Log into the web-based configuration (192.168.0.1) and configure the WAN
side to use PPPOE.

Step 2 Enter your screen name followed by @aol.com for the user name. Enter
your AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything
higher than 1400.

Step 4 Apply settings.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different internet service provider and want
to use the AOL software, you can do that without configuring the router’s firewall
settings. You need to configure the AOL software to connect using TCP/IP.

Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web

browser and enter the |P Wirtual Server is used to allow Internet users access to LAN senices
Address of your D-Link router & Enabled © Disablad
(192.168.0.1). Enter username Name [poamwneel Clear |
(admin) and your password Private I 182.168.0.100
(blank by default)- Frotocal Type  |UDP 'l

Private Port 22
Step 2 Click on Advanced Pulic Port [ iZ

on top and then click Virtual Schecle @ Aways

Server on the left side. € From time [00 =] : [007=] [am =] to [00 =] - [00 =] [ =]

Step 3 Check Enabled to soy[Son 2 vofEun =]
activate entry.

Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone
that was set up between North Korea and South Korea following the UN police action
in the early 1950s.) A DMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access
to Web sites or other companies accessible on the public network. The DMZ host
then initiates sessions for these requests on the public network. However, the DMZ
host is not able to initiate a session back into the private network. It can only forward
packets that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served

to the outside world. However, the DMZ provides access to no other company data.
In the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

a DMz

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the
local network. The DMZ, or Demilitarized Zone, will allow the specified computer
to be exposed to the Internet. DMZ is useful when a certain application or game
does not work through the firewall. The computer that is configured for DMZ will be
completely vulnerable on the Internet, so it is suggested that you try opening ports
from the Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based configuration ReliE=azREFEIHE]
of the router by typing in the IP Address = M
of the router (default:192.168.0.1) in your "215'1 L
web browser. The username is admin (all
lowercase) and the password is blank

(nothing)

Di-524UP

User name: |ﬁ admin v|

Password: | |

[C1Remember my password

[ Ok ] [ Cancel

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable
and type in the IP Address you found in step 1.

D-Link AirPlus G
Step 4 Click Apply 802.11g/2.4GHz Wireless Router
and then Continue to | Home WUZTLEYR Tools | Status Help

save the changes. L

DMZ(Dermilitarized Zone) is used to allow a single computer on the LAN to be exposed to
the Internet

¢

Note: When DMZ is

enabled, Virtual Server e . 1?;”;“‘;%““‘%
settings will still be

i Application -
effective. Remember, 9 9 O

you cannot forward the

il

. Filter Apply Cancel Help
same port to multiple
IP Addresses, so the Firewall
Virtual Server settings
will take priority over

DMZ settings. omz

[

Performance
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Frequently Asked Questions (continued)

How do | open a range of ports on my DI-524UP using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.

Step 3 Click on
Enabled and type in a

D-Link

AirPlus G

name for the new rule 802.11g/2.4GHz Wireless Router
. DI-52 WP‘ m Advanced hi.l1H Status Help
step 4 Choose WAN FWEW;HRLHES can be used io allow or deny traffic from passing through the DI-524UP
as the Source and OEnabled O Disabled
Virtual Server arng |:|
enter a range of IP Bt T

Addresses out on the
internet that you would

Interface I Start IP End Protocol  PortRange

Application

Source [ ™ |

il

Il

H H H estination :’7‘& e & [ U]
like this rule applied Filter peamarr [+ ML | ] 8 ]
to. If you would like Sefiectle Omwms
th yl t " ” Firewall O From  Time |00 ¥ {00 ¥ Tp !E__V__:fﬂv__i

is rule to allow a 4oy[5m P[5 ¥
internet users to be DDNS 9 OO0

able to access these

I

Apply Cancel Help

DMz

ports, then put an
Asterisk in the first
box and leave the

second box empty.

Pratacal
ICMP.

Destination
WAN®

Source
WAN®

Actionhame

Allow Allow to Ping WAMN port
Deny Default i LAM™
Allow Default LAN*

Performance

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming
service,

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer

and then open port 81 to the other computer. 82



Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an
FTP Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and
a VPN server at 192.168.0.7, then you need to specify the following virtual server
mapping table:

Ceoron | s |

21 192.168.0.5 X
80 192.168.0.6 X
1723 192.168.0.7 X

How do | use PC Anywhere with my DI-524UP router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.

Step 1 Open your web browser and enter the IP Address of the router
(192.168.0.1).

Step 2 Click on Advanced at the top and then click Virtual Server on the left side.

Step 3 Enter the Virtual Server _
information as seen Yirtual Server is used to allow Internet users access to LAN services.
below. The Private IP @ Enabled ¢ Disabled
is the IP Address of the Name [peanywhere1 Clear |
computer on your local Private IP [18z 1680100
network that you want Protacal Type ITP;,
to connect to. Private Port  [22

Public Port 22
Step 4 The first entry Schedule & Always
will read as shown here: ¢ From time [002]  [00.=] [AM =] 1o [00 =] . [00 =] [AM =]

day m to m

Step 5 Click Apply
and then click Continue. 83



Frequently Asked Questions (continued)

How do | use PC Anywhere with my DI-524UP router? (continued)

Step 6 Create
a second entry Yirtual Server is used to allow Internet users access to LAN services.

as shown here: & Enabled ¢ Disabled

Marme |poanywhere? Clear |
Private IP |192.1EB.D.1DD

Fratocol Type ITCP 'l
Private Port |5631

Step 7 Click Public Port  [5631
Apply and then Schedule & Always
click Continue. € From tirne |00 =] - [00 =] |AM =] 1o [00 =] Jo0 =] [aM =]

day|5un vImISun vl

Step 8 Create . ] ,
a third and final Yirtual Server is used to allow Internet users access to LAN serices.

entry as shown

@ Enabled © Disabled
here:

Mame |pc:anywher93 Clear |

Private IP 192.166.0.100

Protacol Type Im
Private Port W
Public Pot  [5632
Schedule & Always
€ From time |00 7] - [00 =] |AM =] 1o |00 x| - f00 ~] [AM =]
day [Sun 2] to[5un 7]

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address.
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Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link Router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server
4662 (TCP) To connect with other clients
(

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.

Step 3 Create a new firewall rule:
Click Enabled.

Enter a name (edonkey).

Click Allow.

Next to Source, select WAN

under interface. In the first box,
enter an *. Leave the second box ﬁ_,.
empty.

D-Lin

Buinimg Firtworts or Srop

D|-521UPj

Next to Destination, select LAN (v |
under interface. Enter the IP e
Address of the computer you are

running eDonkey from. Leave
the second box empty. Under
Protocol, select *. In the port
range boxes, enter 4661 in the
first box and then 4665 in the
second box. Click Always or set

a schedule.

Firewall

]
]
=

Step 4 Click Apply and then Continue.

AirPilus G
802.11g/2.4GHz Wireless Router

| Home WVITTRSSW Tools  Status Help

Firewall Rules can be used to allow or deny traffic rom passing through the DE-SI4UF.
(D Enabled (O Digshled
Mamg lurkey
Action O Adiowe 3 Duerry
Intertace 1P Stat w End Frotocol  Fon Hangs
Source wian v |+
Destination |Lan % |1sznmoam R
Seheduts &) Atways
O From  Time | 0 3000 3T 00 300 v
fay S % S
@ 9O
Apply Cancel Help
Artion Name dource Destnation Frotocol
Allgw Allcrer o Ping WAN post VAN AN L=, A
Deny Default b LANT bl
Allow Default LAN® g
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 2?

To allow you to play SOCOM and hear audio, you must download the latest firmware

for the router (if needed), enable Game Mode, and open port 6869 to the IP Address
of your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router
(192.168.0.1). Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue

D-Link

BUIKIMg Networks for Peopie

AirPlus G

802.119/2.4GHz Wireless Router
BTN Advanced BT Status Help
Dl—524UF'|
‘. Virtual Serveris uged 1o allow Intermet users access to LAN senvices
@ Enabled O Disabled
Virtual Server Nara o — —
Private IP 182.156.0/100 |
Rpplication Protocol Type  [Both |
Private Port ] |
Public Part =3 |
Schedule ® Alweays
e e = e
day|Sun
T [Sen;
— 2 9O
I bmz Apply Cancel Help
Marne Private IP Pratacol Schedule
Virtual Setver FTP 0000 TCP21721  always 45
Virtual Server HTTP 0000 TCPEOIED  ahways [ 5l
Virual Server HTTPS 0.0.00 TCP 4437443 atways B}
Mo e PPN i s R 0 i

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply and
then Continue.
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Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Open your web browser and enter the IP Address of the router
(192.168.0.1). Enter admin for the username and your password (blank by default).

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.
Step 3 You will create 2 entries.

Step 4 Click Enabled and enter Settings:

NAME - Gamespy1 w
B802.11g/2.4GHz Wireless Router

PRIVATE IP - The IP Address - “Home  DEUTION Tools | Status | Help
of your computer that you are | A i i e
running Gamespy from. ©- :

PROTOCOL TYPE - Both

PRIVATE PORT - 3783
PUBLIC PORT - 3783
SCHEDULE - Always.

Click Apply and then continue

W AirPilus G N
B02.11g/2.4GHz Wireless Router

| Home RYRTIRN Tools  Status Help

‘ Virtsl St ks whd 10 aBow Il USEE SECRE 10 LAN Senices
o Naies
1 :
irtaal

Step 5 Enter 2nd entry:
Click Enabled

NAME - Gamespy?2

PRIVATE IP - The IP Address
of your computer that you
are running Gamespy from.

PROTOCOL TYPE - Both
PRIVATE PORT - 6500
PUBLIC PORT - 6500
SCHEDULE - Always.

Click Apply and then continue.
87



Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the Kazaa
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (kazaa for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

| Home FUTTITYR Tools  Status Help
VinuaI'Ser\rer is usedto allow Internet users access to LAN serices.

®Enabled O Disabled

Mame |kazaa |

Private IP 192.168.0/100 |
Protocol Type ITCP_v;

Private Port [1214 |
Public Port 1214 |
Schedule ® Always

1T I
O From  Time|00 w00 wiro|o0 w| 00 v|

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.
For the DI-604, DI-614+. DI-524UP, DI-754, DI-764, or DI-774:

Step 1 Open your web

browser and enter the IP D-Link = -
Address of your router i AirPlus G

802.11g/2.4GHz Wirel Router
(192.168.0.1). Enter username BLETR Advanced Tah sm = Help
(admin) and your password AL . . =
(|eave b|ank)_ I Wirlual Server i used b sllow Infermel users Gecess bo LAN senvices
© Enabled O Disabled
. Name (Warcrail
Step 2 Click on Advanced el ae {imiS
and then click Virtual Server. [rem— ProkcaiTips a8
- Private Part B112
Filter Public Port 8112

Step 3 Create a new entry: Scheduls D Abars
s
Click Enabled. Enter a name O frem  Time 80 %00 %o 00 /{00 ¥

- Sun ™ gp Sun v
(warcraft3). Private IP - Enter S QOO0
the IP Address of the computer Apply Cancel Help
you want to host the game. . _
Select Both for Protocol Type P Py 1
Enter 6112 for both Private Port Virusl Server HTTH 0.0.00 TCPEOED  ahways _r{[]
Vit Seevar HTTPS aonn TCP 4437443 atways @i

and Public Port Click Always or
set a schedule.
Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.




Frequently Asked Questions (continued)

How do | use NetMeeting with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs
like Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or
other h.323 software packages.

The solution is to put the router in DMZ.

Note: A few hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients

Step 1 Open your web browser and enter the IP Address of your router

(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

Step 3 Create a new firewall rule:

D-Link

Buiming Metwors for Feupis

Click Enabled.
Enter a name

AaPlus S

802.11g/2.4GHz Wireless Router
(ichat1). . [ Home RULICN Tools | Status Help
Click Allow. - - R S b S R M O
NeXt tO Source, - : & Enabled ) Disabled
select WAN under |zl e B
interface. |-‘|.1'erral:: I-l;'s.:i;’:‘ P End Protocol ot Rtangs
In the first box, — e =
enter an *. Schedule @ Aways
Leave the second el i
box empty. 2 OO
Next to Destination, Apply Cancel Help
select LAN under Eirawall Ridas L
interface. | e
Enter the IP e i = i =
Address of the

computer you are running iChat from.

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.
Click Always or set a schedule.

D-Link

Buiming Mermerks or Poopie

AarPlus G

802.119/2.4GHz Wireless Router

Step 4 Click Apply and A [ Home WUNTLTtl Tools | Status | Help
then continue- ‘ l .FIIrI”;I;:RIIJI;:s(znnn||5M|mallnwnrﬂﬂn\l":ﬂ:rwnmpaﬂhmgIhrmlghlhnl’)l-.’»)tUP
— = Enanted O Disabied
m M lchalZ
Action @ anow O Doy
st =2 Im“: IIP Stan 1P End Frotacal Fot Rangs
ep 5 Dastination LAN » 192 168 0 100 [E 16384 L 18403
Repeat steps 3 and 4 e
enter ichat2 and open FR=wsk B e e WL
ports 16384-16403 (UDP). |zl @ OO0
Apply Cancel Help
(AR Souree Destination Protozal
Dy Datault : th,; . :
Allow Default LAN*
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing:

Step 1 Click on Advanced -
and then Virtual Server. ArPius G
802.11g/2.4GHz Wirelass Router

Step 2 Check Enabled to ! | Homs POLLLCY Tools | Status | Hsip
aCtiVate entry. ‘ I i’.r‘ewalllm.llelseanne uzed fo allow or demy ras from passing through the D-S24U0,
& Enabled ) Desablind
Step 3 Enter a name for your Neme [
virtual server entry (ichat3). - Mo By e G
lll“‘lliﬂ- facy 1 i i ofucol "ol Range
Bourr: il VAN v -
step 4 NeXt to Private Destination  [Lan s| [ issoam T M| s L
IP, enter the IP Address of — Senae ;’:‘*‘*‘ TR
the computer on your local Wy SO
network that you want to allow Q@ OO0
the incoming service to. e Apply Cancel. Mol
Fit 11 Kule 1
[Ty Aclion Nan Sowce Desination Protocol
Step 5 Select TCP for I S ——————
Deny Default B LANT s
Protocol Type. b S

Step 6 Enter 5190 next to Private Port and Public Port.
Stsp 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV

Step 8 Click OK.

92




Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall is
active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X fire-
wall, the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may
keep the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.
Step 3 Click the Firewall tab.
Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number
5190 should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X
are outlined in technical document 106461, “Mac OS X: File Sharing” in the AppleCare
Knowledge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click

the Firewall tab and select the service you have chosen in the “Allow” list. If you do not
do this, the firewall will also block the file sharing service. *
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. It is proposed and described in
RFC-1631 and is used for solving the IP Address depletion problem. Basically, each
NAT box has a table consisting of pairs of local IP Addresses and globally unique
addresses, by which the box can “translate” the local IP Addresses to global address
and vice versa. Simply put, it is a method of connecting multiple computers to the
Internet (or any other IP network) using one IP Address.

D-Link’s broadband routers (ie: DI-604) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our web
site, or by phone.

Tech Support for customers within the United States:
D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:
D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
e Serial number of the unit

o Model number or product name

o Software type and version number
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Warranty and Registration
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

. D-Link or its authorized reseller or distributor and
. Products purchased and delivered within the fifty states of the United States, the District of Columbia,
U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described below will
be free from material defects in workmanship and materials from the date of original retail purchase of the
product, for the period set forth below applicable to the product type (“Warranty Period”), except as otherwise
stated herein.

3-Year Limited Warranty for the Product(s) is defined as follows:

e  Hardware (excluding power supplies and fans) Three (3) Years
e  Power Supplies and Fans One (1) Year
e  Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period at
no charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will be
rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be new or
have an identical make, model or part. D-Link may in its sole discretion replace the defective Hardware (or
any part thereof) with any reconditioned product that D-Link reasonably determines is substantially equivalent
(or superior) in all material respects to the defective Hardware. Repaired or replacement Hardware will be
warranted for the remainder of the original Warranty Period from the date of original retail purchase. If a
material defect is incapable of correction, or if D-Link determines in its sole discretion that it is not practical to
repair or replace the defective Hardware, the price paid by the original purchaser for the defective Hardware
will be refunded by D-Link upon return to D-Link of the defective Hardware. All Hardware (or part thereof)
that is replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link
upon replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”) will
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in the
applicable documentation, from the date of original retail purchase of the Software for a period of ninety (90)
days (“Warranty Period”), provided that the Software is properly installed on approved hardware and operated
as contemplated in its documentation. D-Link further warrants that, during the Warranty Period, the magnetic
media on which D-Link delivers the Software will be free of physical defects. D-Link’s sole obligation shall
be to replace the non-conforming Software (or defective media) with software that substantially conforms
to D-Link’s functional specifications for the Software or to refund at D-Link’s sole discretion. Except as
otherwise agreed by D-Link in writing, the replacement Software is provided only to the original licensee,
and is subject to the terms and conditions of the license granted by D-Link for the Software. Software will
be warranted for the remainder of the original Warranty Period from the date or original retail purchase. If
a material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it
is not practical to replace the non-conforming Software, the price paid by the original licensee for the non-
conforming Software will be refunded by D-Link; provided that the non-conforming Software (and all copies
thereof) is first returned to D-Link. The license granted respecting any Software for which a refund is given
automatically terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software of D-
Link’s products will not be applied to and does not cover any refurbished product and any product purchased
through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the liquidators
expressly disclaim their warranty obligation pertaining to the product and in that case, the product is being
sold “As-Is” without any warranty whatsoever including, without limitation, the Limited Warranty as described
herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its return

policy. In case the return policy period has expired and the product is within warranty, the customer shall
submit a claim to D-Link as outlined below:
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. The customer must submit with the product as part of the claim a written description of the Hardware
defect or Software nonconformance in sufficient detail to allow D-Link to confirm the same.

e  The original product owner must obtain a Return Material Authorization (“RMA”) number from
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of the
product (such as a copy of the dated purchase invoice for the product) before the warranty service
is provided.

e  After an RMA number is issued, the defective product must be packaged securely in the original
or other suitable shipping package to ensure that it will not be damaged in transit, and the RMA
number must be prominently marked on the outside of the package. Do not include any manuals
or accessories in the shipping package. D-Link will only replace the defective portion of the Product
and will not ship back any accessories.

e  The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD”) is allowed. Products sent COD will either be rejected by D-Link or become the property
of D-Link. Products shall be fully insured by the customer. D-Link will not be held responsible for
any packages that are lost in transit to D-Link. The repaired or replaced packages will be shipped
to the customer via UPS Ground or any common carrier selected by D-Link, with shipping charges
prepaid. Expedited shipping is available if shipping charges are prepaid by the customer and upon
request.

Return Merchandise Ship-To Address
USA 17595 Mt. Herrmann, Fountain Valley, CA 92708
Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed warranty
information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product that
is not packaged and shipped in accordance with the foregoing requirements, or that is determined by D-Link
not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced or
removed; Initial installation, installation and removal of the product for repair, and shipping costs; Operational
adjustments covered in the operating manual for the product, and normal maintenance; Damage that occurs
in shipment, due to act of God, failures due to power surge, and cosmetic damage; Any hardware, software,
firmware or other products or services provided by anyone other than D-Link; Products that have been
purchased from inventory clearance or liquidation sales or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product. Repair by anyone other
than D-Link or an Authorized D-Link Service Office will void this Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY
TERRITORY WHERE APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE
LIMITED TO NINETY (90) DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY
PROVIDED HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND PERFORMANCE OF
THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER
ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FORANY
LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER
DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES
FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE
OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’S
PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON, OR
INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING

FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEENADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS REPAIR,
REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT. THE MAXIMUM
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LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE
PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES
AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES,
EXPRESS, IMPLIED OR STATUTORY.

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some states
do not allow exclusion or limitation of incidental or consequential damages, or limitations on how long an
implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited warranty provides
specific legal rights and the product owner may also have other rights which vary from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product

may be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976. Contents are subject to change without prior notice.

Copyright® 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communication. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.

. Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e  Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.

FCC Caution:

The manufacturer is not responsible for any radio or TV interference caused by unauthorized
modifications to this equipment; such modifications could void the user’s authority to operate the
equipment.

(1) The devices are restricted to indoor operations within the 5.15 to 5.25GHz range. (2) For this
device to operate in the 5.15 to 5.25GHz range, the devices must use integral antennas.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. The antenna(s) used for this equipment must be installed to provide a separation
distance of at least eight inches (20 cm) from all persons.

This equipment must not be operated in conjunction with any other antenna.

[ Register your D-Link product online at http://support.dlink.com/register/ ]
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